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Dear Parent/Guardian,

Thank you for choosing the Oregon Scientific Accelerator Vision.

Designed and engineered with extreme precision,

the Accelerator Vision is packed full of learning,

offering stimulating games and activities that

make an invaluable contribution to your child’s development.

Some of the activities to further your child’s skills include language,

mathematics, music, memory and logical reasoning.

The Accelerator Vision provides a dependable and

realistic introduction to computers and

encourages creativity and independent learning.

Learning with Oregon Scientific is so much fun!
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About your Accelerator Vision Learning PC
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Features

76 Activities
• Vocabulary / Spelling
• Mathematics
• Trivia
• Games / Language Tutor
• Reference / Tools
• PDA / Keyboard Skills
• Web Area

Internet Zone
• Safe-site.net capable
• Free email account
• Download new questions
• Post game scores
• Profanity check
• Newsgroups
• Design your own web page 

and host it at the safe-site.net  
server

The Accelerator Vision is supplied with the following parts.Please contact your 
retailer should any parts be missing.

1 - Unit
2 - Mouse Pad
3 - Opti-mechanical mouse 
4 - Instruction manual for X-Cable   
5 - User Manual for the 

Accelerator Vision
6 - X-Cable software 

CD-ROM
7 - X-Cable
8 - Registration password

Unit

X-Cable software CD-ROM X-Cable Registration password

Mouse jack USB port AC jack

USBX-Cable 
Connection to PC
• Trnsfer document between

the Accelerator Vision 
an PC

• Print to any PC 
compatible printer

• Internet Connection
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1. Make sure the unit is turned off.
2. Using a Phillips screwdriver, open the big battery cover at the back of the unit.
3. Insert 4 AAA size batteries. (Note the correct polarity +, - ).
4. Replace the cover.(The unit is automatically turned on as soon as the batteries are 

installed or the adaptor is plugged in.)

1. Make sure the unit is turned off.
2. Using a Phillips screwdriver, open the small battery cover at the back of the unit.
3. Insert 2 AA size batteries. (Note the correct polarity +, -- ).
4. Replace the batteries and cover.

NOTE: Back-up batteries are essential for the retention of stored data.

Back-up battery installation

Your Accelerator Vision operates on 4 AAA size batteries plus 2 AA size batteries
(not included), or a 9V AC adaptor (not included).

Getting Started

Battery Installation

Caution

• Do not mix old and new batteries.
• Do not mix alkaline, standard (carbon --zinc) or rechargeable (nickel-cadmium) batteries.
• Remove all batteries when replacing.
• Remove the batteries from the unit if it is not going be used for long periods.
• Do not dispose of batteries in fire.
• Do not attempt to recharge ordinary batteries.

Power failure may corrupt data stored in the memory.  To reset your Accelerator Vision, see “Memory Failure”
in the Trouble Shooting section.

Auto-off
The learning PC will be automatically turned off after about 6 minutes of no input from the player.

AC Adaptor Connection
1. Plug the adaptor into the adaptor jack at the back of the unit.
2. Plug the adaptor into a wall outlet

Caution
• The unit must not be connected to a power supply of more than 9V.
• Only use the unit with the recommended adaptor.
• The adaptor is not a toy.
• The supply terminals are not to be short-circuited.



Password Screen

Logging in

1. From the pull-down menu, select your name.
2. Enter the password in the Password field and press [ Enter ]. (If you have forgotten the password, 

click on [ Hint ] to see your pre-entered clue).

Logging in as “Guest”
From the pull-down menu, select “Guest”, and press [ Enter ].
NOTE: Users who log in as "Guest" will not be able to save any information or acces to the web area.
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Useful Features and Controls

Scroll Bar

To view continuing pages, click on the arrows at the bottom of the bar or press the down arrow key.  
To view previous pages, click on the arrows at the top of the bar or press the up arrow key.

Demo
Press this key to see a demonstration of the exciting features and activities on your Accelerator Vision Learning PC.

5

6

Cleaning and Maintenance
• The unit should be regularly examined for damage to the adaptor, the adaptor cord, 

enclosure and other parts. In the event of such damage, the unit must not be used 
with the adaptor until the damage has been repaired.

• Do not dismantle the unit.
• Always disconnect the power supply before cleaning.
•  Do not get the unit wet.
• Wipe the unit with a dry cloth.

Mouse Connection
1.  Ensure that the unit is turned OFF.
2.  Open the mouse jack cover on the back of the unit.
3.  Plug the mouse into the mouse jack 
4.  Turn the unit ON.
5.  To prolong the life of the mouse, only use it on a clean mouse pad.

Starting Accelerator Vision Learning PC

When you first turn on the Accelerator Vision you will be asked to do the following:
1.  Click on the words “ YourName”.  You will be prompted to type in your name and then press Enter.  

N.B.: This should be the same name you use when you install the X-Cable software in your PC.
2.  Enter a password and then press Enter.  Do this again to confirm the password and then press Enter.
3.  Set the date and time and then press Enter.
4.  Select your time zone and then press Enter.



A. Making a selection with the touch pad - also called “Clicking on”
Use the touch pad to position the cursor arrow over the desired icon and press the left button.

B. Making a selection with the mouse - also called “clicking on”
Use the mouse to position the cursor arrow over the desired icon and press the left mouse button.

C. Making a selection with the arrow keys 
Press the arrow keys to highlight the desired icon and press [ Enter ].

D. Making a selection using the keyboard
For multiple-choice questions, type in the letter corresponding to the chosen answer.

Undoing a selection/Return to previous screens/Quitting a game
Click on the exit icon at the top right of the title bar or press the [ ESC ] key on the keyboard. 

Main Menu
When the power is turned on, a welcome animation is shown, followed by the main menu.  This menu 
consists of 8 sectors.  To reveal what activities are available in each sector, select a sector by clicking 
on one of the icons using the touch pad or mouse (see making a selection).
Remark: you can also assign keys to open any activity with the Hot Key settings

X-Cable
Please refer to the X-Cable manual.

The Keyboard
The keyboard operates in the same way as a computer keyboard or typewriter. 

Cursor
The arrow cursor can be controlled by the mouse or touch pad.

The Touch Pad 
Use this to control the arrow cursor.  Just move your finger across the touch pad in the direction that you
wish the cursor to move.

The Mouse
This controls the arrow cursor.  Move the mouse, on the mouse pad in the direction that you would like
the cursor to move.  The left mouse button functions as a select key and [ Enter ] key 
(see “ Making a Selection” below).

The Flashing Cursor
This shows where the next typing entry will appear.  This can be repositioned by moving the
cursor arrow to a new position, and clicking the left mouse/touch pad button.

Making a Selection
In most of the activities, you will need to make a selection.  This can be done in the follow-

ing four ways:
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These rules apply to most games.

Attempts
You have three attempts to answer each question correctly.

Time Limit
There is a time limit for answers to be entered.  (About one minute for each question).   The clock resets
after each incorrect attempt.  However, if the time elapses before an answer is submitted, then no more
attempts to answer that question are allowed, and the game proceeds to the next question. 

Help
Use "Help" to see the instructions.
a. Press [ Help ] on the keyboard, OR
b. Click the triangle on the top of the screen.

While the Help screen is open, the game's clock stops.  Click on the exit icon, or press [ Esc ] to exit Help
and resume the game.

Chapter 4Chapter 4
Game Rules

Hints
In some activities, you are allowed to get a hint from the learning PC.  Select [ Hint ] from 
the Help screen or press Function + [ T ].  But remember there is a maximum of two hints 
per question, and a point is deducted for each hint used.  Activities with the hint function are: 
Jail Break (1&2player),Word Shuffle, and Anagram Slam.

Level/Score/Time Remaining
These are displayed on the Instruction/Help screen. (also see "Help").

Answer
If you don't know the answer to a question, you can press [ Ctrl ] + [ A] to see the answer.  No points are
awarded.

Levels
There are five levels in each game.  There are 10 questions for each level, and your movement between
levels depends on your performance on the level just completed (see the table below). After a round of
questions, a summary screen appears to show the score and whether you advance a level, go back a level,
or stay at the same level.

Score Movement

Above 85% Advance to the next level

61%-84% Repeat the current level

Below 60% Move down to the previous level
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Changing the Password
1. Type the your new password in the “ New Password” field and the “ Confirm Password”      

field. The same word must be entered in both of these fields. 
(An asterisk is displayed for each letter entered so that your password remains a secret.)

2. Enter a clue in the “ Hint” field to remind yourself of the password in case you forget.
• Reset the password by removing and replacing the back-up batteries.  

Be sure to leave all batteries out for at least 10 minutes to clear the memory.
• NOTE: Back-up batteries are essential for the retention of stored data. 

Removing the back-up batteries will delete all stored data.

Screen Saver
The Screen Saver protects the screen from damage from a prolonged period of exposure 
to one image.  If there is no input for more than a set period of time, the Screen Saver is
turned on automatically.  As soon as any key is pressed the Screen Saver is turned off and 
the previous screen returns. The time that elapses before the Screen Saver picture comes 
on can be changed.

1. Select “ Screen Saver”.
2. Select the elapsed time before the Screen Saver comes on.
3. Press [ Enter ] or select [ OK ] to save the changes or [ Cancel ] to ignore any changes.

One point is deducted for each hint used (maximum of two per question).

Your score is totaled only when you advance a level or when or you quit the current level.

Penalty (minus 100 x level) will be applied for those who move down to the previous level. 

For example: If you are in level 1 and you score 95 points you move up to level 2.
In level 2 you only score 45 points, then your cumulative points are 95-100, 
and you must go back to level 1.

Winning a Game
Beat level 5 and discover a special surprise. Good Luck!  

If a question is answered correctly Points awarded e.g Level 2    e.g :evel 3

1st Attempt 10 x level 10 x 2 = 20 10 x 3 = 30

2nd Attempt 6 x level 6 x 2 = 12 6 x 3 = 18

3rd Attempt 3 x level 3 x 2 = 6 3 x 3 = 9

Scores
Points are awarded according to the number of attempts taken to answer each question correctly.
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User Settings
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CHANGE GRAPHIC
TO "Atom, Space, 
X-Cable" in the pull
down menu



Volume
You can adjust the volume to a lower setting.
1. You can press [ Function ] + [ Q ] to go to the volume setting screen.
2. Click on the plus or minus button or press the arrow keys to move the button to the 

desired volume level.
3. Click on [ OK ] or press [ Enter ] to set any changes, or click 

on [Cancel] to ignore any changes.

The Contrast Setting Screen
Depending on the surrounding lighting conditions, adjust the contrast for better viewing.
The Accelerator Vision features a 10 level adjust.
1. You can press [ Function ] + [ W ] to go to the Contrast setting screen.
2. Click on the plus or minus button or press the arrow keys to move the button 

to the desired level.
3. Click on [ OK ] or press [ Enter ] to set the changes or [ Cancel ] to ignore any changes.

The Voice Setting Screen
1. Click on [ On ] or [Off] to activate or de-activate the voice prompts.
2. Click on [ OK ] or press [ Enter ] to set the changes or [ Cancel ] to ignore any changes.

The Time and Date Setting Screen
1. At the Setting sub-menu, select “ Time/Date”, OR press [ Function ] + [ E ] to go to the Time/date 

setting screen.
2. Set the date by selecting the month, day and year from the pull-down menu.
3. Set the time by highlighting the field and pressing the up or down arrow keys to change

the hour/minutes/am/pm components. Click on the time box again to confirm the time set.
4. Click on the box to activate/deactivate the 24-hour clock.

Assigning  Hot Key Settings
At the Setting sub-menu, select “ Hot Key”.
Assign any of the activities to the F1-F12 keys by selecting from the pull down menu.
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WORD SECTOR

Activities

Spelling Zone
Jail Break
Your mission is to prevent the villain from escaping from jail.  At the bottom of the screen
is a secret word.  You are given 10 free points at the beginning of each question and you are
allowed 3 incorrect guesses after which 2 points are deducted for each incorrect guess.  
You have 7 guesses for each question. With each incorrect guess a bar will be removed from
the jail. When all the bars are taken away, the villain will escape from the jail.

Jail Break - 2 players
Play against a friend.  Take turns to score as many points as possible.
Player 1 - Enter a word (maximum 9 characters)
Player 2 - Prevent the villain from escaping from jail (see instructions for Jail Break)



Word Warp
You must select the correct answer from the choices given.

Letter Eliminator
A word appears spelled incorrectly with an extra letter.  Remove the letter by shooting it
with the Air Fighter. The Air Fighter is controlled by using  the left and right arrow keys.
Once you select a letter, press the space bar or [ Enter ] to fire a laser beam to eliminate the
extra letter.

Word Shuffle
A scrambled card appears on the screen.  Unscramble the cards to reveal the word.  
Insert the unscrambled cards at the bottom by typing in the word using the keyboard 
or using the arrow keys.

Grammar Zone
Word Detective
For each word that appears at the bottom of the screen, 
you must click on the appropriate part of speech that it belongs to.

Capital Caper
On the screen is a sentence.  Identify the words that require capitalization
or uncapitalization and correct them by:
1. Using the arrow key, or clicking on the word(s).
2. Press [ Capitalized ] or [ Un-capitalized ] to submit your answer.
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Punctuation Perfection
A sentence with a punctuation error appears on the screen.
1. Select the incorrect punctuation mark and click [ Enter ] to highlight it.
2. Replace this with the correct punctuation mark by selecting from the list at the bottom.

Grammar Jammer
You must select the correct answer from the choices given.

Vocabulary Zone
Like It Or Not
Apair of words appears on the screen.  Choose whether  they are an antonym, a synonym or neither by
pressing one of the three buttons.

Word Transformer
Aword appears on the screen.  By changing one letter, another word can be formed.  There is also a  
clue given.  Change one letter to form the new word and  press [ Enter ]. 

VOCABULARY SECTOR



Anto-Match
Flip over two tiles at a time and try to match up pairs that are antonyms.
Each game consists of 5 pairs and each pair is  worth 2 points. 

Syno-Match
Flip over two tiles at a time and try to match up pairs that are synonyms.
Each game consists of 5 pairs and each pair is  worth 2 points. 

Game Zone
Word Quest
You are shown a list of words found in a grid.  When you are ready to find the words 
press [ Enter ] and the clock will begin to count down.  All words read from left to right 
or top to bottom.

1. Select the first letter of a word, hold down the shift key and then select the last letter.
2. Press [ Enter ] each time a word has been found.

You can view the list of words again by pressing the [ List ] button on the screen 
but the clock will continue to count down.

Word Quest – 2 player
This game is played like to Word Quest but with 2 players.
Player 1 – Type in words for Player 2 to find.  After typing each word, press [ Enter ].
Player 2 – Look at and memorize the words to be found and when you are ready,
press [ Enter ] to start searching.
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Anagram Slam
Rearrange the letters of the word to find the anagram. 
Simply type in your answer.

Silly Stories
Enter in  words according to the part of speech indicated. Press [ Enter ] after each word.

Crypto – Code
Guess a four-letter word. To fill in your answer, type in in and press [ Enter ]. 
In each level, you have 10 guesses.
The following will help you make the correct guess:
1.)  the solid cross mark - X indicates a correct letter and a correct corresponding position
2.)  the hollow cross mark indicates a correct letter, but the wrong position
3.)  a blank space indicates a wrong letter and position. 

You are given 3 attempts to answer each question correctly.  Good Luck!

Submit your answer by:
1.  Typing in the answer or using the mouse or touch pad to click on the on-screen number pad.
2. Some games require the answer to be submitted in a different way, in which case the 

instruction is given with the game description.

NOTE: If you type in the answer incorrectly, press [ Back Space ] to make a correction.

MATHEMATICS SECTOR



Basic Math Zone 
Addition, Subtraction, Multiplication and Division 
These games challenge the basic arithmetic skills of addition, subtraction, multiplication and
division.  Fill in the box with the correct answer.

Fraction Zone
Fraction Tutor
This is a fun introduction to fractions. Scroll down to reveal more pages and up to return to
the previous pages.  Some pages have places to click on the screen that show interactive 
pictures to help you understand.

Fractions Addition/ Subtraction and Multiplication/Division
Develop your fraction skills by solving these problems.
1. Type the answer in the boxes.

Fraction Comparison
This activity challenges your understanding of fractions. 
There is a box with three buttons: [ < ], [ = ] and [ > ].
Two fractions appear on the screen and if you think the first fraction is:

a) Greater than the second fraction, then click on [ > ] and press [ Enter ].
b) Less than the second fraction, then click on [ < ] and press [ Enter ].
c) The same size as the second fraction, then click on [ = ] and press [ Enter ].

Fraction Reaction
4 fractions appear on the screen, you must select the one that is different from the others.
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Decimal Zone
Decimal Tutor
This is a fun introduction to decimals.  Scroll down to reveal more pages or up to return 
to the previous page.  On some pages, there are places to click on the screen that show you
interactive pictures to help you understand decimals.

Decimals Addition / Subtraction and Multiplication / Division
The purpose of these games is to develop your skill in decimal arithmetic.
Fill in the boxes with the correct answer.

Percentage Tutor
This is a fun introduction to percentages. 
Scroll down to reveal more pages or up to return to the previous page. 
With some pages, there are places to click on the screen that show you interactive pictures 
to help you understand.

Percentages Problems
Be perfect at percentages by solving these problems.
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Geometry Zone
3D Geometry Tutor
This tutor will illustrate geometry formulas (area, volume, and angles) using 3D animtions.
When a new formula is introduced, there will be a button to show the animation and an 
example.

Geometry Problem
Solve these questions to prove that you really are a geometry genius!
Type your answers in the box and press [ Enter ]

Mathematics Game Zone
Big or Little
This activity challenges your understanding of Mathematics. 
There is a box with three buttons: [ < ], [ = ] and [ > ].
Two equations appear on the screen and if you think the first equation is:

a. Greater than the second, then click on [ > ] and press [ Enter ]. 
b. Less than the second, then click on [ < ] and press [ Enter ].
c. The same size as the second, then click on [ = ] and press [ Enter ].

Operation Order
You are given 3 numbers.  You must enter each of the 3 given numbers into the correct boxes,
thus creating a correct equation. 

A. MATHEMATICS SECTOR

Trivia Zone
Science Trivia, History Trivia, and World Trivia
Test and improve your general knowledge in the Trivia Zone!
Just select the correct answer.

Place Your Order
You are given four pieces of information.  Rearrange them in the proper order according
to the description. 

Games
Repeat the Beat
Repeat the sequence shown by clicking on the tone buttons or by typing the tone number.
See the sequence again by pressing the [ Repeat ] button.
You can only use the [ Repeat ] button once in each question.

TRIVIA / GAMES SECTOR
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Water Balloon Attack
Uncover all of the squares except the water balloons as quickly as possible.  Click on a square to reveal 
what’s behind it.

1. If a number appears in the square, this number describes how many balloons are in the surrounding 
8 squares.

2. If it is a balloon, then the game is over and a new game begins.

3. If there are no balloons in the surrounding 8 squares, no number is shown and all adjoining squares 
are uncovered.

4. If you believe there is a balloon behind a covered square, you can mark it with a flag by clicking the 
right mouse button.

5. If you believe you have marked all of  the balloons around the numbered squares, you can uncover 
all the empty squares around it by clicking on it with both mouse buttons.

The timer starts counting as soon as the first move is made.

Note:  
Level 1,  is 6 squares across by 8 squares tall, with 8 balloons.
Level 2,  is 8 squares across by 8 squares tall, with 16 balloons.
Level3, is 12 squares across by 8 squares tall, with 24 balloons.

Scoring
Level 1: 500 points minus the time it takes in seconds.
Level 2: 1000 points minus the time it takes in seconds.
Level 3: 1500 points minus the time it takes in seconds.

Code Buster
Game-play is similar to Crypto-Code, but instead of guessing four-letter words, 
you guess numbers (1- 6).
To submit your answer, type in your answer and press [ Enter ].
In each level, you have 10 guesses.  If you complete a level within the given amount of time, 
you can advance a level.

Indicator:

• In this game the position of the circles does not correspond to position of the numbers.
• A filled circle indicates the correct position and the right number.
•  An empty circle indicates  the wrong position, but the right number.
• The blank space indicates an incorrect number and position 

Note:
•   Level 1: 4 columns.
•   Level 2: 5 columns.
•   Level 3: 6 columns.

Crystal Ball
This game tells you the fortune that you will have.
Think of a question and then press [ Enter ].
After the crystal ball stops rotating, the screen then turns to reveal the answer.
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Super Snake
The snake is controlled by arrow keys - once a direction is pressed, it keeps going until 
another direction is pressed.
The snake cannot hit itself or the wall.  It grows bigger when fruit is eaten.
Each level has 10 pieces of fruit.  In order to move to the next level, 
you must eat all the pieces of fruit.
There are 5 levels, and the speed of the snake is faster in each higher level.

Brick Breaker
You use the paddle to hit the ball and remove all the bricks.  
Use the arrow buttons to control the paddle.
There are 5 levels. If you fail to hit the ball 3 times, the game is over and 
a new game begins.

Skill Zone
Keyboard Tutor
Scroll down the document and follow the instructions given in the tutorial pages.
(With some pages, there will be places to click on the screen that will show you pictures to help you
understand.)

SKILL / PDA CENTER

Hyper Typer
Find your typing speed.
Type the given paragraph.  As you type the words, any errors are highlighted.
At the end of the paragraph, a summary screen appears showing the total number of characters typed 
and your accuracy percentage.

Keyboard Conveyor
A conveyor belt appears on the screen. Letters start rolling out on the belt. 

You must type the letters as they appear and stop them from falling off into the bin.

PDA Zone
Address Book
This special feature offers a comprehensive and convenient way to store important telephone numbers 

and contacts. Depending on memory, a maximum of 96 contacts can be stored.

•   Adding a new entry
1.  Select "New" from the title bar.
2.  The flashing cursor appears in the name field.  Type in a name and press [ Enter ] 

or [Tab].  The flashing cursor moves to the next field.  Complete the remaining
fields in the same way.  (There is a maximum of 15 characters in the telephone 
number field.)  Use the scroll bar to view further down the page.

3.  Click [ Save ] on the screen or press [ Ctrl ] + [ S ] to save the entry or [ Cancel ] to 
disregard any changes.

Note: Only the name field must be filled in.  All the other fields can be skipped and filled 
in later. Move between fields by clicking the cursor arrow in the desired fields or 
pressing [ Enter ] or [ Tab ]. The Address Book can store a maximum of 96 contacts.
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•  Finding a record with the Search function
1. Entries are listed alphabetically by name.

Use the scroll bar to view entries further down the page, or 
2. Select “Search” from the title bar.
3. Type in the name you are looking for and press [Enter].

•  To view all the fields of an entry
1. Highlight the entry you want to view and press [Edit]
2. Alternately, double click on the selected entry

•  To print the telephone list (only name and phone number)
1. Select “Print” from the title bar. 

If the printer is not connected to your PC, a warning screen appears.
Make sure the printer is connected and switched on.

2. Click on [Yes] to print or [No] to abort the print command. 

•   To delete an Address Book entry
1.  Highlight the entry you want to remove.
2.  From the title bar, select “Delete”.  A warning screen appears.
3. Click on [Yes] to delete or [No] to cancel.

•   To edit a saved Address Book entry
1.  Highlight the entry you want to edit.
2.  Select “Edit” from the title bar.
3.  Move the flashing cursor to the required field and type over the old information.
4.  Click on “Save” on the title bar to update the entry or [Esc] to ignore the changes.

•  To print a full Address Book record
1.  Highlight the selected record and press [Edit] to print from the Edit window.
2.  Select “Print” from the title bar. 

If the printer is not connected to your PC, a warning screen appears.
Make sure the printer is connected and switched on.

3. Click on [Yes] to print or [No] to abort the print command.  

Calendar
The calendar opens with today's date highlighted.  If there is a day reminder 
or an appointment on that day, that day is highlighted on the calendar.

• Changing the displayed months and years
To display preceding months, click on the month back icon (_).
To display future months, click on the month forward icon (_).

•  Accessing the Appointment Book from the Calendar
You can access the Appointment Book from the Calendar.
Highlight the day you want to view, then select “Appointment book”.

•  Accessing the Day Reminder from the Calendar
You can access the Day Reminder from the Calendar.
When the Calendar screen is opened, select “Day Reminder”
from the bottom right of the screen.
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Tool Zone
Word Processor
With the Accelerator Vision, you can create and print your own documents.
You can even transfer them to your PC for editing.  (See the X-Cable Manual)

Printing:
The Accelerator Vision comes with a standard keyboard. Use the letter and number keys to type your text.

• Shift Key 
Hold down the ‘Shift’ key while pressing another key to make uppercase letters or to create punctuation
marks and symbols as shown on the top part of the keys.

• Caps Lock Key 
Press this key to lock letters into upper or lower case.

• Back Space 
Press this key to delete the character to the left of the flashing cursor or any selected, highlighted text.

• Delete
Press this key to delete a character to the right of the flashing cursor or any highlighted text.

• Enter key
Press this key to go to the next line.

• Arrow Keys
Use these to insert the flashing cursor anywhere in the text field.  The flashing cursor cannot be moved
beyond the limits of the active text.

TOOLS/REFERENCE CENTER

Day Reminder
The Accelerator Vision will also remind you of special dates by displaying a message on 
the screen every time the unit is turned on from 7 days before, up until the actual date.  
When this activity is open, today’s date is shown.  You can review the record by selecting 
the Task number.

1. Creating and Editing Reminders
• Select a task number.  (You can set different tasks to run at the same time).
• Select a date by clicking on the arrows in the date bar
• Change the time by clicking on the time display and using the up and down arrow 

keys to adjust it.
• Type in your message in the content field.
• Select 7 days or Yearly.  If you choose Yearly the reminder will work every year.
• Press [Save] to save the records or [Del] to delete the records.

Appointment Book
The built-in personal appointment book can remind you of special meetings and dates.
Alarm: The unit will ring you up when the 

1. Creating and Editing Appointments
• Turn to the required date
• Select a Task number.  (You can set different tasks to run at the same time).
• Click on the hour/minute components of the clock and press the arrow keys to set the time.
• Click on the message box and type in the appointment details.
• Click on [Alarm] or [Reminder].

➪ ➪ The Reminder option displays a message at the marked time but only if the unit is turned on.
➪➪ The Alarm option sets off an alarm at the designated time even if the unit is turned off.
➪➪ Click on [Save] to save the changes or [Delete] to delete the records.
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• Highlighting /selecting a block of text
Format blocks of text by highlighting the text first.
1. Click twice on the first character of the text to be highlighted.
2. Click on the last character of the text to be highlighted.
NOTE: Only one block of text can be highlighted at a time.

• Space Bar
Press this to insert a space

•   Opening a menu
1.  Keyboard method: 

To open the File menu, press [Alt] + [F]
To open the Edit menu, press [Alt] + [D]
To open the Format menu, press [Alt] + [O]
To open the Tools menu, press [Alt] + [T]

2.  Mouse/touch pad method:
Click on the desired menu option.

•   Selecting from menus
Once a menu is opened, you can select from the listed options by clicking on that option or pressing the 
key combinations shown beside the menu options.

•   Selecting from a different menu
Once a menu is opened, a different menu can be opened by using arrow keys on the keyboard.

Moving Blocks of Text (Cutting/Copying and Pasting)
Cutting Text (also see Highlighting and Pasting):

1.  Highlight the block of text to be moved.
2.  Select “Cut” from the Edit menu or press [Ctrl] + [X]
3.  Paste the block into its new position [Ctrl] + [V]

Copying Text (See Pasting):
1.  Highlight the block of text to be copied.
2.  Select “Copy” from the Edit menu or press [Ctrl] + [C]
3.  Paste the block into its new position.

Pasting Text:
The last selection of text that has been copied or cut can be pasted to a new position.

1.  Place the cursor at the new position for the text.
2.  Select “Paste” from the Edit menu or press [Ctrl] + [V].

Bold
Make the highlighted text or a new section of text boldface by selecting “Bold” from the Format menu or press [Ctrl] + [B].

Italicize
Italicize highlighted text or a new section of text by selecting “Italic” from the Format menu or press [Ctrl]  + [I].

Underline
Underline highlighted text or a new section of text by selecting “Underline” from the Format menu or press [Ctrl] + [U].
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•  File menu
Start a new document:
Select “New” from the File menu or press [Ctrl] + [N].

Open an existing/saved document:
1. Select “Open” from the File menu or press [Ctrl] + [O]. A list of documents are shown.
2. Select the document you wish to open by:

a. clicking on the document name or
b. using the up/down arrow keys to highlight the document name and press [Enter].

The “Open” command is cancelled by selecting [Cancel] or pressing the [ESC] key.

Save a document:
Remember to save your document and any changes made so you can continue working on the latest 
document in the future.

1. Select “Save” from the File menu or press [Ctrl] + [S].
If it is the first time that the document has been saved, you are prompted to type in a name for 
the document.

2. Click on [OK] or press [Enter].

To delete a current document:
If you no longer need a file, remove it from the learning PC’s memory.  This releases more memory to save other files.

1. Select “Delete” from the File menu or press [Ctrl] + [D].
2. A dialogue box appears asking you to confirm the deletion.

Click on [OK] to confirm, or [cancel] or escape icon to cancel the delete command. 

Please note that the Accelerator Vision can store a maximum of twenty-four documents depending on the file size of each.

Print:
Select “Print” to print out the current document. Remember to check that the: 
1. Printer is connected to your PC and power is on.
2. X-Cable is attached to your PC.

Exit:
Selecting this option closes the Word Processor and returns you to the Tool Zone menu.

Scoreboard
Use the pull-down menu to see either Personal Best scores or Challenge Game scores.
The scores of each game are listed in the score display field.  Scroll down to see all 
the scores.  Then you can:

1. Click on [Print] to print out the current scores in the display field, or
2. Click on [Clear] to clear the Personal Best list if the list is displayed.

World Time
Check the current time around the world.  Select the country where you want to learn 
the time.  You can select up to four different countries at a time.

Alarm Clock
The alarm can be turned off by pressing the space bar on the keyboard.

1  Click on the alarm sound menu and select a sound.
2. Activate the alarm by clicking on the alarm field so “On” is displayed. 

Deactivate the alarm by clicking on the alarm field so “Off” is displayed.
3. Set the alarm time by clicking on the time display. The hour component begins to flash.

Set the hour of the alarm using the up/down arrow keys. Remember to specify 
am or pm.  Move to minutes by pressing the left/right arrow keys then change the minutes using 
the up/down arrow keys.
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Creative Zone
Percussion Pro
There are six different drums to create a composition.

1. Produce the sounds by
a. Clicking on the pads.
b. Pressing the corresponding keyboard keys (show beside each picture).

2. Click on [_] to start Recording. 
3. Click on [_] to pause the recording  
4. Click on [_] to hear your composition.  If there is no recording, nothing plays back.
5. Click [Clear] to clear the recorded composition.
6. Click on [Pause] to insert a pause in between the tunes.

Music Station
1. There are 10 music melodies that you can choose to play.
2. Press the letter keys to see different animation effects on the screen.

Sequencer
Use 6 musical instruments to create a composition.

1. Select an instrument from the right hand side menu.  Click on any instrument, and the instrument 
becomes highlighted.

2. Produce the sounds by
a. Clicking on the keyboard.
b. Pressing the corresponding keyboard keys (shown on the keyboard).

3. Click on [_] to start recording. 
4. Click on [_] to pause the recording 
5. Click on [_] to hear your composition.  If there is no recording, nothing plays back.
6. Click [Clear] to clear the recorded composition.
7. Click on [Pause] to insert a pause in between the tunes.    

Music Tutor

Note Name
Learn about note name by clicking on the note mark on the staff.  
It will tell you the name of the note.

Note Length
Learn about note length by clicking on the note mark on the staff.  
It will tell you the length of the note.

Rest
Learn about rest name by clicking on the rest mark on the staff.  
It will tell you the name of the rest.

Note Quiz
A note is displayed on the staff randomly.  Select the correct note name by clicking 
on a choice at the bottom.

Musical Mathematics
A random  musical equation is displayed.  You select the note that makes a correct equation.
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Reference Zone
Calculator

The built-in calculator has an eight-character display.
Click on the numbers or operands on the on-screen number pad and press [Enter], 
or key in the equation using the keyboard and press [Enter] to see the answer.

Graphic Calculator
This activity plots equations and functions into accurate graphs.
Enter an equation in the field and click on [Graph].
If the equation is valid, the graph appears in the graph field.

Metric Converter
Enter a number beside the known unit and it is converted to the corresponding U.S. 
standard / metric measurement.  Scroll down for additional choices.

Part of Speech
This is a grammar reference area that defines parts of speech and provides examples.

World Atlas
Learn about over 190 different countries around the world.  
1. Click on a continent to show a new map with a list of the countries located there.
2. To see the location of the country, click on the name of the country.
3. Press [Enter] or double-click on the country name and a document appears with statistical 

information about the country
4. Click on [X], to return to the country name list.

Language Zone
Super Translator

You can learn common phrases in 6 languages

French Italian Portuguese   
German Japanese Spanish

Select a word from the English field to hear that word, first in English, 
then in another language.

Translation Test
Test your ability to understand a foreign language.
Read the question carefully, and then select the correct answer from the choices.

Oregon Scientific’s Web Area, a closed system, is custom designed for children to have fun
and learn more about the Internet without the risk of being exposed to inappropriate adult
material or the possibility of being contacted by dangerous people.
The Web Area has unique filters, one of which is a specially developed profanity checker
to ensure that no e-mail, sent or received, contains profanity.  The Web Area also features 
an online Access Control List that allows parents to select who can e-mail their child.

Additionally there is another exciting feature that can lets you create your own web page and
upload it to safe-site.net.

For the connection to safe-site.net, please go to the Uplink activity. 
(Also see “How to synchronize with your home PC” below).

WEB AREA
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E-mail

Your child can send e-mail to all Internet users, and you can decide who may send e-mail to your child 
through the online Access Control List at: www.safe-site.net                                                                          

To create an e-mail

1. Go to File and select “New” 
2. Type in an address in the “To” field
3. Add in a Subject
4. Type in your message 
5. Press send
6. Make sure to go to Uplink to connect to the Internet 

(Reminder:  your PC must already have a connection and be online.)   
Depending on the size of each message, a maximum of 70 e-mails can be stored on the Accelerator Vision.

Newsgroups
Your child can participate in newsgroups managed and filtered by Oregon Scientific.
Each one contains topics of interest for your child to discuss with their peers.

Read a message: 
After each synchronization,  your newsgroups will be updated.

Post a message:
To add a message press [Post] and then you must go to the Uplink window and connect
to the Internet.

Download Questions
Periodically, your child can download fun new educational questions from the Web Area.

Card Gallery
From the choice  of greeting cards, your child can select one, fill it in, and send it to another 
Safe-site member or to any Internet user.

Sending a greeting Card
1. Type in an e-mail address
2. Select a greeting card and press [Next] to enter your message 
3. Press [E-mail]

Printing a Greeting Card 
You may also  print it out through your home PC’s printer.

1. Select a greeting Card and enter your message
2. Press [Print]

Remarks:
There are two choices: the Large Card folds an A4 paper in half, and the Small Card folds it in quarters.  
You can select the choices on the PC  (see also Card Viewer in the X-Cable manual)  

Score
The Web Area stores  and updates a list of the top 10 verified scores for the 10 “Challenge”
Games in the Accelerator Vision.
When you access the Web Area, it automatically updates the scoreboard and lets you
know if you are in the top 10. 
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Web Page Designer
1) First select a template (each template consists of 4 pages)

2) Next, enters the content for each page.

3) Afterwards there are two options - view on the PC or upload to Safe-site.net.

• If you choose “PC”, the web pages will only send the file to the PC after  the next
synchronization.  

• If you choose “Safe-site” the web page will be sent both to the PC and
Safe-site (web.safe- site.net/log in_name).  (Also see safe-site.net registration)
(http://web.safe.site.net/your login name)

REMEMBER: In order to send to Safe-site.net your Accelerator Vision must be 
connected to a PC that is connected to the Internet.

Uplink

Establish a connection with the Accelerator Vision to the Server and the PC.

1. Enter the log in name and password into the fields

2. Press [Connect] or [function] + [       ] to start the “ Synchronization”
process with your home PC.                                                              

For Recovery (Also see the X-Cable Manual – Recovery)
•   Please select the option as shown in the picture.  You can backup files on the PC

from the Vision or the other way round.

A safe introduction to Internet communication for children

We all want our children to learn valuable Internet skills without the possibility of encountering undesirable web sites.

That’s why we designed www.safe-site.net

Our Web Area’s stylish design provides the same up-to-date activities that are available to all web users but in a child-safe, 
friendly environment.  With Safe-site.net, children can build real Internet skills in a fun and exciting way.

Chapter 7Chapter 7
Safe-site.net
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“Top 10” scoreboard
If your score is in the top 10, then your name will appear on the scoreboard until it is surpassed.

Web Page Designer
Design your own web page and host it at our Safe-site server.

How to sign up for safe-site.net:
Activating the account: 
The product comes with a secret password for the parent that is used to open the safe-site account.
It can be found on a separate piece of paper attached to the manual, and labeled “Access Key”.

The parent first registers the product using the access key on our web site (www.safe-site.net) and obtains
the Safe-site e-mail account (log in name & password) for their kids.  An additional parent password is also given to oversee
control of the account (also see Password for Parents).

Password for Kids:
Kids can enter the log in name and password through the Uplink activity to gain access to the Web Area.

Password for Parents:
Parent can control two main aspects:
1. The publication of the Web  Page:

When you press Uplink or [ function ] + [       ], a pop up window with the message “Please enter your 
parent password” will appear.  If you fail to enter the password, your web page cannot be viewed on the 
World Wide Web.  Additionally the parent password can be used to control the web page uploaded onto the 
World Wide Web.

2.  You may control access to the child’s account through use of the ‘Admin’ site (www.safe-site.net) 
Here you may:

• Filter any unwanted e-mail.
• Delete the web pages.

Synchronization is the process that transfers data (such as Web activities) back and forth between the Internet,
the PC, and the Accelerator Vision.  
1.  Go to the Web Area and select Uplink.
2.  Enter the log in name and password (obtained after web registration).
3.  Press [connect] or [function] + [       ] to begin the synchronization.

Note: the log in name and password are obtained after your web registration.  (also see “How to sign up for safe-site.net” )

The Accelerator Vision is sold with the X-Cable (a USB device) for use with your home PC.  The X-Cable
connection is used for Web activities, Printing, and System recovery.  For more detailed information, please
refer to the X-Cable manual.

How to synchronize with your home PC

X-Cable

Chapter 9Chapter 9

Chapter 8Chapter 8
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Chapter 10Chapter 10
Trouble Shooting

Before contacting an an authorized service center, please carry out the following simple checks. 
You may call at 1-800-THESHCK (843-7422) to speak to a customer service representative.

No Display
Is the power supply connected?
Are the batteries installed properly?
Do the batteries need replacing?

Difficult or no response from the mouse
Is the ball of the mouse or mouse pad clean and free from dust?
Is the mouse connected correctly?

Cannot connect to the Web or use Email
Have you established the Internet connection on your PC?
Please check the safe-site log in name and password are entered correctly.
Please check that the X-Cable is securely attached to your PC and the Accelerator Vision.

Cannot Print
Have you correctly connected your printer to your PC?
Is the printer cable securely attached to your PC?
Please check that the X-Cable is securely attached to your PC and the Accelerator Vision. 

Black-out screen or abnormal display
Disconnect the power supply by removing the batteries or disconnecting the adaptor for at least 10 seconds
before connecting the power supply again.

Memory Failure
In the unlikely event that the memory becomes corrupted, reset your Accelerator Vision by:

1. Removing all batteries, including back-up batteries and leave the machine unplugged for 30 minutes. OR:
2. Press [R] + [On] to reset.  (Warning: All memory will be erased.)

Developing learning aids is a responsibility that we at Oregon Scientific take very seriously. We make every
effort to ensure the accuracy and appropriateness of the content that forms the value of our products.However,
errors can sometimes occur. It is important for you to know that we stand behind our products and we 
encourage you to call our Consumer Services Department at1-800-853-8883 with any problems and/or 
suggestions that you might have. Our service representatives will be happy to help you.

Conforms to safety requirements of ASTM F963, EN71 Parts 1,2 & 3 and EN50088.
In an effort to continually improve our products, the actual screen display on the product may differ 
slightly from the diagrams shown.



Limited Ninety-Day Warranty
This product is warranted by RadioShack against manufacturing defects in material and workmanship under normal
use for ninety (90) days from the date of purchase from RadioShack company-owned stores and authorized Ra-
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Warning: 
Changes or modifications to this unit not expressly approved by the party responsible 
for compliance could void the user's authority to operate the equipment.

NOTE: 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation.
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the
following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio TV technician for help.
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